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FLIMfit is a software package for the analysis and visualisation of time-resolved data from FLIM (Fluorescence
Lifetime Imaging) measurements. It uses highly efficient algorithms that can globally fit FLIM data with modest
photon numbers to complex decay models, across hundreds or thousands of fields of view, requiring only tens of
seconds of processing time on a reasonable desktop computer. This makes it useful to analyse time series or multiwell
plate FLIM data. The algorithms used in FLIMfit are discussed in detail in Warren et al, 2013.
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CHAPTER 1

Contents

1.1 GUI Documentation

1.1.1 Menus

File menu

New Window Open a new instance of FLIMfit in a new window.

Load FLIM Data Load a single FLIM image. The program can load the following FLIM file formats: B&H .sdt,
LaVision TCSPC OME-tiffs, ASCII .txt files, a set of wide-field time-gated .tif images in a single directory and
FLIMfit .raw files.

Load FLIM Dataset Load the raw FLIM data from multiple FOVs or multiple time or Z (depth) points. These FOVs
can then be analysed together as a single dataset.

Load Polarisation Resolved Data Load polarisation resolved FLIM data. Polarisation analysis needs 2 images acquired
at different polarizer angles, so the data must have at least 2 FLIM channels (this is currently only implemented for
for B&H TCSPC .sdt images).

Load Acceptor Images Load a set of acceptor images that correspond to a set of FLIM images of the donor that you
have already loaded. The acceptor images may be used to segment the data into ROIs based on both the donor and
acceptor channel in inter-molecular FRET experiments and to plot the acceptor intensity. The file names of acceptor
images must contain the names of the corresponding FLIM files to be recognised.

Reload Data Attempt to reload the currently loaded dataset. This can be useful when processing a dataset during
acquisition when not all of the images had been acquired when the data was first loaded. This option requires that the
data folders have been created in advance of the acquisition.

Save FLIM Data Reserved for future use.

Save as Raw Dataset Save the currently loaded data as a .raw file. The .raw file is useful as it can be rapidly
reloaded using the Load Raw Dataset option, which can save time when dealing with large datasets.

Save Data Settings Save the settings of the Data tab into an XML file by using the Save Data Settings menu option.
You can then load the settings back into FLIMfit when necessary by using Load Data Settings menu option.

Set Default Folder Set the default folder to use for file loading dialog boxes. This is useful as it saves repeatedly
navigating to the folder that your data is stored in when opening e.g. IRF files.

Import Plate Metadata load the description of multi-well plate reader data. This description is stored in special Excel
format.
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Export Decay save the current pixel decay and the IRF displayed in the Decay tab, in text format. This option
asks the user to select a directory and a file name, and the program then saves two .txt files called filename.txt and
filename_irf.txt.

Export Initial Fit Parameters You can save all the settings shown in the fitting parameters tab into an XML file by using
the Export Initial Fit Parameters menu option. These settings can then be loaded back in to FLIMfit when necessary
by using Import Initial Fit Parameters menu options.

Export Fit Results as HDF Save the fitted decay parameters into a HDF format. The HDF (“hierarchical data format”)
is suitable for storing large amounts of data with complex structure.

Export Fit Results Table Save the global fitted variables shown in the Parameters tab to a .csv file.

Export Images Export the fit parameter images selected in the Plot tab as both colormapped images (i.e. including
colour bar and scale) and floating point grayscale parameter image files (tiff images).

Export Histograms Save the current data in the Histogram tab as a .csv file.

OMERO menu

Set Working Data select the current OMERO storage containing FLIM images – either Dataset or SWP Plate. The
logon options include possibility to enter as different user (Switch User), and restore server connection (Restore
Logon).

Load FLIM data: Single FOV load a single FLIM image from the pre-set OMERO storage.

Load FLIM data: Multiple FOVs load multiple FLIM images from the pre-set OMERO storage. These images should
have the same XYZCT dimensions.

Load IRF (Single FOV) load an IRF from a multi-plane image. A multi-plane OMERO image with the same XY
dimensions and FLIM delays as the loaded FLIM data is expected. The data in this image are averaged over XY to
produce 1-dimensional IRF signal.

Load IRF (Dataset Images to average) load the IRF from an OMERO dataset containing a set of single plane images
with the values of FLIM delays (expressed in picoseconds) encoded in image names. This command is equivalent to
loading the IRF from a folder on disk using the File, Load IRF menu option.

Load IRF (Annotation) load an IRF from an OMERO Annotation file within the current working data (Dataset or
Plate). The files, including single-pixel B&H decays are loaded by the same procedure as when loading from the disk.

Load Background (single plane: Image) load a background image. A single-plane image is expected. This is analogous
to the Load Background Image option from the Background menu.

Load Background (single plane: Dataset Images to smooth) calculate an averaged background image from a selected
Dataset containing a set of single-plane images. This is analogous to the Load series of background images to smooth
option in the Background menu.

Load Time Varying Background (Image) load a TVB image. This is analogous to the Load Time Varying Background
option in the Background menu.

Load Time Varying Background (Dataset Images) load a TVB image from an OMERO Dataset. This is analogous to
the Load IRF (Dataset Images). The 1-dimensional time-dependent TVB signal is calculated by averaging this data
over the XY dimensions.

Export Fitting Results store the current values displayed in the fitting results tab into OMERO. Internally within
FLIMfit, the results of a fit are stored as double precision XY parameter images (i.e. several for each FOV, depending
on the number of fit parameters). When exporting the fit parameter data into OMERO, these parameter images are
placed in a multi-plane “double” OMERO image along the “channels” dimension. In other words, the OME dimension
of each exported FOV results in an image with XY dimensions equal to the FOV, Z=1, T=1 and C = Nfit_params, where
Nfit_params is the number fitted parameters. Fitted data are exported as a new OMERO container of the same storage
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type as working data (i.e. either a new Dataset or a new Plate) with the name derived from the name of the analysed
working data. The name of the new OMERO container also contains the global time when the fit was performed.

Export Fitting Settings attach an XML file containing the current fitting settings of the program as a File Annotation
to the current working data in OMERO (Dataset or Plate). This allows the fit settings to be reloaded back into FLIMfit
from OMERO by using the Import Fitting Settings menu item.

IRF menu

Load IRF load an IRF from file. If image data is selected, all the pixels will be averaged into a single decay.

Set Delta Function IRF set the IRF to a delta-function, i.e. the model functions will be used without convolution.

Estimate IRF Background estimate and subtract the background from the IRF. The background is estimated by fitting
a Gaussian with a constant background to the IRF. The fitted constant value is then applied automatically to the
background cell/value in the IRF tab and replaces any previous value.

Estimate IRF shift estimate any time shift present in the loaded IRF relative to the true IRF due to, for example, colour
effects in the detector. The shift is determined by finding the IRF shift that minimizes the 𝜒2 value (the goodness of
fit measure) obtained for a fit to the region currently selected by the user.

Estimate G factor estimate the G factor using a dye sample with a short rotational correlation time. The G factor is
estimated using the knowledge that the anisotropy tends to zero towards the end of the decay. This procedure is used
only when analysing Polarization resolved measurements.

Background menu

Load Background image load a spatially varying background from an image file on disk that contains a single plane
image matching the XY size of the loaded FLIM data. This sets the values of spatial-varying background ZSV (see
above).

Load series of background image to smooth menu option loads a set of single plane images and automatically calculates
an average background image from them. The user is required to select a folder containing suitable image files.

Load Time Varying Background load a time varying background. This is not spatially varying background - a single
trace is loaded from a .txt file that was saved previously using the Export Decay menu option.

Use Selected Region as Time Varying Background menu option defines the time varying background signal that is not
XY dependent. The time varying background is set to the average of the region that is currently selected by the user.

1.1.2 Fitting options

Lifetime tab

Global Fitting Specify the scope of the global variables.

• Pixel-wise the decays are fitted on a pixel-by-pixel basis

• Image-wise global fitting is performed across each image individually, i.e. lifetimes are constant across each
image

• Global global fitting is performed across the entire dataset, i.e. lifetimes are constant across all images.

Global Variable combo-box to confine the scope of the global fit to a particular multi-well plate metadata parameter
(e.g. ‘Row’ or ‘Column’). If a parameter is selected all images with the same parameter value will be globally analysed
together.

Global Mode combo-box to set up the method of global analysis. The following choices are available:

1.1. GUI Documentation 5
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• Global binning All pixels in the global fit are binned into a single decay. This decay is then fitted to determine
the global parameters. Each pixel is then fitted individually with the global parameters fixed (using the method
of linear least square minimisation) to determine the local variables.

• Global analysis All the pixels in the global fit are simultaneously analysed using Variable Projection algorithm
(see in Advanced tab)

No. Exp combo-box to set up the number of exponential decay components 𝑛𝜏

No. Fixed The number of fixed fluorescence lifetimes; the first No. Fixed values in the Initial Tau list are fixed.

Fit contributions combo-box to set up the fitting mode for the amplitudes Ak (formula (3) and (4)). The following
choices are available:

• Fixed the fractions 𝛽𝑖 are fixed for corresponding amplitudes (set up by the textboxes appearing to the right)

• Fit locally amplitudes are fitted locally, i.e. on a pixel-by-pixel basis

• Fit globally amplitudes are fitted globally, i.e. they are invariant across the image. Use this option when fitting
a complex donor FRET model or polarisation resolved data.

• Fit globally (Grouped): use this option to fit a model where we have a mixture of several fluorophores with
complex decays. The lifetimes and contributions are specified in groups, indexed from zero. Within each group
the lifetime and fractional contributions are invariant across the image but the fractional population of each
group varies locally. The groups are specified using the Initial tau list.

Fit Reference combo-box to set up the fitting mode for the variable 𝜏𝑅 (formula (4)), as Fixed or Fitted. The reference
lifetime is fitted globally.

Initial Tau combo-box to choose the initial values of lifetimes. These are estimated automatically unless ‘Automati-
cally estimate initial guesses’ is deselected.

Stray Light tab

You can select the fitting scope of the “stray light” variables entering the model expressions (3-5), by choosing either
Fixed, or Fitted Locally, or Fitted Globally. The scope is set for the following variables:

• Offset A constant background value, Z in the formula (5)

• Scatter A fast-light scatter contribution, S in the formulas (3) and (4)

• TV Background A time-varying background contribution that is scaled by the coefficient V, see formula (5). This
option can only be used if a time varying background has been loaded. The V coefficient can be fitted globally
or fixed by setting the TVB Background to ‘Fixed’ and TVB to 1.

Anisotropy tab

These options are used to set up an anisotropy decay model if polarisation resolved data has been loaded.

No Decays combo-box to specify the number of rotational correlation times to fit.

No Fixed combo-box to specify the number of rotational correlation times that are fixed. The first No Fixed are fixed
to the value specified in the Phi list.

Use Phi textbox to specify the initial guesses and fixed values for the anisotropy correlation times.
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FRET tab

These options are used to fit a complex-donor FRET decay model. In this model we assume that the donor fluorophore
has two or more conformations with associated lifetimes whose FRET efficiencies are linked by their relative quantum
yields. To use this mode Fit Contributions should be set to Fixed or Globally in the Lifetime tab, as we assume that
the fractional contribution of the various donor species are invariant across the image.

No. FRET Species combo-box to specify the number of different FRET conformations present. For example, for an
intra-molecular FRET probe where there are likely to be two different conformations with different (but non-zero)
FRET efficiencies, set this to two and set Include Donor Only to No. For an inter-molecular FRET probe where the
unbound state will have a zero FRET efficiency, set this to one and set Include Donor Only to Yes.

No. Fixed combo-box to set the number of FRET conformations which have fixed efficiencies. The first No. Fixed
FRET efficiencies in the E list will be fixed.

Include Donor Only combo-box to specify whether a donor-only contribution should be included, that is a contribution
from a species which is not FRETing.

Advanced tab

No. Threads Set up the number of threads used in multi-threading processing. This is automatically set to the number
of cores present on the local machine which in general is optimal.

Algorithm combo-box to choose the method and the type of error function minimization. The following methods are
available:

• Variable Projection: Use separable fitting to minimise the mean-square error function.

• Maximum Likelihood: Use the maximum likelihood fitting metric, only applicable to pixel-wise fitting. Use this
option for fitting data with low photon count numbers, particularly TCSPC data.

Weighting Mode combo-box to select the method of weighting the residuals entering the mean-square error function when using Variable Projection.
Error function =

where ti are the bin (delay) times, 𝜎(ti) is weighting coefficient, and Dmodel(ti) and y(ti) are the model and measured
intensity values, respectively.

• Average Data Weight according to the average measured decay across the global scope. This is the default, and
advised option.

• Pixelwise Data Weight according the measured decay in each pixel \(chi^2(ti)=y(ti)\). Can display significant
bias at low photon counts.

• Model Weight according to the model decay 𝜒2(𝑡𝑖) = 𝐷𝑚𝑜𝑑𝑒𝑙(𝑡𝑖). May lead to problems with convergence if
initial estimates are significantly different from the true values.

Pulse Train Correction combo-box to specify whether incomplete decays should be included in the fit. Unless you
have a very low repetition rate laser source or are fitting very fast decays, this option should only be disabled for testing
and when fitting data simulated without incomplete decays.

Auto Resampling combo-box to dynamically combine bins to ensure that there are at least 10 counts in each bin. This
option is superseded by Maximum Likelihood fitting.

IRF combo-box to set up the type of IRF. The following choices are available:

• Single Point Use the same IRF for all pixels

• SV IRF Use a spatially varying IRF that has been loaded from the IRF menu. Each pixel is fitted using the IRF
from the corresponding pixel in the spatially varying IRF.

1.1. GUI Documentation 7
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IRF shift map Use an IRF shift map that has been loaded from the IRF menu. The same IRF is used in each pixel, time
shifted according to the shift map loaded.

Live Fit checkbox to dynamically refit the currently selected decay as fitted parameters are changed or as the selected
region is changed. This option does not automatically fit the whole dataset.

Calculate Errors checkbox to estimate confidence intervals on the global parameters based on the F statistic. This
option should currently be considered experimental and significantly increases the fitting time.

1.1.3 Instrument and preprocessing options

Data tab

These settings are used to specify data acquisition parameters and set any required pre-processing.

Smoothing The kernel size used for spatially smoothing the data to reduce the noise. The equivalent binning setting in
Becker and Hickl software is provided for reference.

Note: To ensure that the smoothing does not affect the choice of background or threshold values, data is
averaged rather than summed over the kernel. The 𝜒2 value correctly accounts for the level of smoothing
applied.

Integrated Min. Pixels which have an integrated intensity of less than this value will be excluded from the fit. This
may be used to exclude pixels which are too dim to give a good fit.

Note: The integrated intensity is calculated after accounting for the specified background and is not
smoothed.

Time Min. and Time Max. The limits of the valid FLIM signal. Time bins or gates outside of these values will be
excluded from the fit. Use this to remove, e.g. TCSPC data which falls outside of the linear range of the TAC.

Counts/Photon The average number of digital counts recorded per photon. This is used to correct the 𝜒2 value to
account for the gain provided by the intensifier and camera.

Tip: For TCSPC data this should be left at 1.

Rep. Rate The repetition rate of the laser used to acquire the data, in MHz. This is used to correct for incomplete
decays.

Warning: This value must be set correctly; if it is set incorrectly the fitting may fail or produce a
very poor fit.

Gate Max. Saturation limit of the data. Pixels which have a time bin or gate above this limit will be excluded from the
fit. This can be used to exclude saturated pixels which will bias the fit.

Tip:

For 16-bit TCSPC data (e.g. B&H, LaVision) use 65,536.
For 12-bit time gated data use 4,096.
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Background tab

The settings in this tab are used to set the background subtraction. These options subtract a background from the data
before fitting.

Tip: A background due to detector dark noise or stray room light should be added to the model rather than being
subtracted, otherwise the fit will be weighted incorrectly. See backgrounds for more information.

Background The type of background to subtract:

None No background value
Single
Value

A constant value, e.g. camera offset

Image A background image, subtracted uniformly from every time bin or gate. Use to correct for a
non-uniform background due to, e.g. camera non-uniformities

TV
Image

A time varying background (TVB) image. Use to account for time and spatially varying background
fluorescence, e.g. due to plate fluorescence with non-uniform illumination

Background Value The background value subtracted if Single Value is selected in Background.

IRF tab

The settings in this tab relate to the Instrument Response Function (IRF) and how it is processed. See irfs for more
information.

IRF Type The type of IRF loaded

Scatter An IRF recorded with a scattering sample or raman signal.
Reference A mono-exponential decay recorded with a reference dye.

Reference Lifetime The lifetime of the reference decay. This value will only be used if IRF type is set to Reference.

Background The level background present in the IRF. The background signal level is estimated automatically after
loading, see Estimate IRF Background option in the IRF menu.

BG is Afterpulsing. Whether the background in the IRF is due to afterpulsing. If so, the background value is used to
compensate for the afterpulsing, otherwise the background value is subtracted from the IRF.

Time Min. and Time Max.‘ The limits of the valid FLIM signal. Time bins or gates outside of these values will be
removed from the IRF.

IRF Shift Shift in picoseconds to apply to the IRF.

G Factor The relative sensitivities of the parallel and perpendicular detector channels for polarisation resolved data.

1.2 Loading Plate Data in FLIMfit

1.2.1 Setup calibration data

• Determine IRF shift

– Load reference data

– Set background, rep rate

– Load library IRF

1.2. Loading Plate Data in FLIMfit 9
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– Adjust ‘IRF shift’ until the edge of the IRF sits roughly at the rising edge

– Fit mono exponential model with free IRF shift

– Check quality of fit

– Note t0 value. This value should be subtracted from the IRF shift used

• Create time varying background

– Load media only well

– Load camera background

– Select central region

– Select Tools>Export SV TVB...

1.2.2 Loading data

• Load data

• Load plate metadata

• Load camera background images

• Set laser repetition rate

• Set gate maximum to camera saturation value

• Load IRF and set IRF shift from reference measurement

• Load time varying background

• Save as raw dataset

1.3 Advanced Topics

1.3.1 Creating a library IRF

Overview

• Measurement of the temporal profile of an HRI for particular settings

• Caution Take care to minimise the light exposure on the HRI at all times

Measurement

• Set up for widefield imaging with HRI of interest

• Use filter cube with achromatic beamsplitter with ~OD5 of absorptive ND filters

• Focus light on glass slide (~4% reflection)

• Record the temporal profile with 25ps gate spacings

• Record 100 laser off background images with same integration time
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FLIMfit Documentation, Release 4.11.1

Create library IRF file

• Load measured IRF as FLIM data

• Load camera background

• Check for decay artefacts

• Select small central region of image

• Select Tools>Create IRF shift map...

• Add to instrument calibration repository

1.3.2 Determining a reference lifetime

• Load a long lifetime dye data (or a single lifetime dataset, e.g. a cell expressing GFP only)

• Remove the background appropriately

• IRF > Load IRF

• Advanced tab > Select Use IRF shift map

• Check that IRF shift map is displaying and is correct by selecting IRF shift map in the mode selector

• In Fitting tab > set Fit reference to Fitted

• Fit image wise both the lifetime of the sample and the reference lifetime

• The reference lifetime obtained can then be used for fitting other dataset using the xml IRF shift map file as IRF

1.4 Experimental design

1.4.1 General Considerations

1. Imaging media

• Choose to minimise background fluorescence

(a) Avoid FBS and Phenol Red if possible

(b) Avoid Methylene Blue for IR imaging

(c) Some slide/well coatings are fluorescent

• Will depend on metabolites required for cells, e.g.

(a) EBSS + 4mM Gln, 1mM NaPyruvate, 2mM CaCl2, 1 mM MgSO4 (Anca and Sean)

(b) HBSS (Chris) with additional HEPES if needed

(c) Invitrogen Fluorobrite (George)

4. CO2 control required?

• Required for some imaging media

• Often possible to avoid CO2 if using appropriate buffered media (e.g. HEPES)

5. Temperature control

• Experiment at RT or 37°C?

1.4. Experimental design 11
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• Turn on incubator previous evening, heating stage several hours before

• Use objective heater collar if using immersion fluid

• Equilibrate dishes after media changes in incubator

• Must allow temperature to equilibrate after positioning dish on microscope (10-15mins)

• Monitor room temperature (USB temperature monitor available)

6. Humidity

• Consider evaporation during long term imaging

• Humidify image chamber if possible

• Seal plates if possible (but may lead to pH change if CO2 required)

• Use layer of mineral oil on well

7. Stimulation

• Ideally use flow chamber

• Control temperature of stimulation media

• Consider diffusion effects if adding small volumes

• Check for mechanical disturbance after adding stimulant

• Always make control measurements with vehicle only, e.g. DMSO to check for flat baseline

• Check for fluorescence from stimulants

8. Imaging Substrate

• Make sure you know the properties/thickness of coverslip/well bottom

• Generally use No 1.5 coverslips

• Clean coverslips with ethanol before use

1.4.2 Multi-well plate experiment design

Consider including the following control/calibration wells in your plate

1. Suitable controls (will depend on sample), consider

• Donor alone

• Positive control (e.g. constitutively active protein)

• Negative control (non-binding partner)

• Donor with free acceptor

2. Empty well with same imaging media

• Treat the same as the other wells during plate setup during media change

3. Untransfected cells

4. Reference dye

Other issues to consider include

• Plastic well plates are fluorescent in blue/green

– Glass bottom plates preferable optically, but not compatible with some cells lines
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• Edge effects

• Pipetting strategy

1.4.3 Choosing a reference dye

• Reference dye should be a bright, mono-exponential fluorophore

• Suggestions for common imaging channels

– CFP channel: Green chromaslide

– YFP channel: Green chromaslide

– GFP channel: Green chromaslide

– RFP channel: Rhodamine 6G

• Chromaslides are good when monoexponential as no anisotropy artefacts

• Reference dyes should be dissolved directly in water

– Mixed solvents can lead to multi-exponential decay

• Use low concentration, 10uM generally good

– Avoid inner filter, re-absorbtion

1.5 Multiphoton TCSPC FLIM Checklist

1.5.1 Before imaging

1. Read the Becker and Hickl handbook

2. Check emission filters

• 700SP clean-up filter commonly used in addition to spectral filter

• Check for laser bleedthrough

3. Check triggering stability

• Correct sync rate?

4. Check laser power and mode-locking stability

• Check for slow drift

5. Adjust slow delay box

• Position start of decay at around 20% of imaging window

6. Acquire gold nano-rod IRF

• See this paper for more details

• Available from Sigma, product code 716820

• Use ~1mW excitation power for IRF

• Acquire background image USIC

7. Check power levels

• Check for negligible change in intensity, lifetime over imaging period

1.5. Multiphoton TCSPC FLIM Checklist 13
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• Photobleaching rate scales non-linearly with power, consider imaging for longer with lower powers

8. Reduce background light as far as possible

• Room lights

• Monitors

9. Acquire reference dye measurement to test system

• Fit reference dye before starting imaging

• Check for mono-exponential decay, correct lifetime

1.5.2 During imaging

1. Keep peak *pixel* count rates below at least 5% of repetition rate

• Understand pulse pileup effects

• Consider image fill factor when monitoring count rate

2. Monitor count rate for photobleaching

1.5.3 After imaging

1. Repeat reference dye measurement to check for system drift

2. Acquire images of untransfected cells USIC

3. Acquire background image of empty dish with imaging media USIC

4. Check laser power level

1.6 Time Gated FLIM Checklist

1.6.1 Setting up imaging

1. Set HRI gain

• Maximise gain on HRI to reduce excess noise

– Use ND filters such that you get 2-3 digital counts per photon.

– Characterise the HRI with a known flux (see Doug’s thesis)

2. Choose gating strategy

• Choose ~7 gates, more when sample lifetime is poorly characterised

• One in rising edge, one at peak and rest distributed logarithmically

• Fewer, correctly chosen gates maximises lifetime resolution per unit time

• Example picture

3. Set gate width

• Maximise gate width

• Ensuring last gate does not catch rising edge of next pulse
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4. Set integration time

• Brightest sample should fill ~¾ of camera dynamic range

5. Set number of accumulated frames

• Ensure sufficient photon flux in dimmest ROI

• Make sure that background recorded in same way.

1.6.2 Before imaging

1. Check calibration files

• Library IRF for this HRI with chosen gate width and gain and relay magnification

• Delay box calibration at the repetition rate of the laser

• Plate definition file (XPLT)?

2. Check HRI triggering

• Using oscilloscope, should be stable pulse to pulse

• Check triggering, gate settings are consistent

3. Make sure condenser is optically blocked (they fluorescence in the blue)

4. Check laser power stability

• Measure after fibre

• Always use single mode fibre

• Coupling efficiency should be 40-50%

– Check beam profile and fibre end face

• Check for slow drift, fluctuations on 0.1-1Hz scale in particular

5. Measure mono-exponential reference dye to obtain t0 and check system

• Use 25ps gate spacing

• Fit reference dye before starting imaging. Should have flat residuals

• Check for mono-exponential decay, correct lifetime

1.6.3 During imaging

1. Monitor laser power level

2. Pray to the FLIM gods

1.6.4 After imaging

1. Repeat reference dye measurement

2. Measure camera background

• Record a series of ~100 images with laser shuttered

• Use same integration time

1.6. Time Gated FLIM Checklist 15
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3. Acquire images of untransfected cells USIC

4. Acquire background image of empty dish with imaging media USIC

5. Check laser power level

1.7 Handling time varying backgrounds

If you have a time varying background (e.g. from media fluorescence) which varies spatially (e.g. due to non-uniform
illumination), you can take this into account in FLIMfit using the following procedure:

Create a time vary background intensity map. This assumes the profile of your TVB is invariant (i.e. the same decay
across the image) but there is an intensity variation. To do this

1. Open your TVB as an image

2. Set an appropriate uniform camera background value (e.g. ~200 for a Hamamatsu camera)

3. Select a region in the centre of the image to average for the decay

4. Go to Tools>Create TVB Intensity Map... and save the file somewhere

Then you need to load and activate the TVB map when analysing data

1. Open your data

2. Load the TVB from Background>Load Time Varying Background

3. In the Background tab, set background to ‘TV Image’

1.8 Frequently asked questions

1.8.1 Fitting

Q. How are the intensities calculated? What is the difference between ‘I0‘ and ‘I‘?

The intensity images shown are integrated intensities, i.e the total sum of all the photon counts in all the time gates
without any smoothing applied. The I parameter shows the integrated intensity, while the I0 parameter gives the model
intensity at t=0.

1.8.2 Exporting Data

Q. How do I export the real lifetime (or other parameter values?)

Select the parameters you’d like to export from the list in the left hand bar and select File>Export Images.... Two files
will be exported for each parameter and each image, one colour-mapped image and another called ‘* raw.tif’ which is
a floating point TIFF file which contains the true parameter values. You can open these files in ImageJ, Matlab or any
other program.

1.8.3 New Users

Q. Are there any tutorials to get me started?

Please see the online help guides at http://help.openmicroscopy.org/flimfit.html
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1.8.4 Estimating IRF shift

Q. When should I use the “Estimate IRF shift” on the IRF menu?

Ideally you won’t use it. This function is provided for those occasions when it’s not possible to measure an irf at the
correct wavelength. In this case there can be a shift in time between the measured irf and the one that you want to
measure. This functionality is provided for those cases. If at all possible it is better to measure the irf rather than
estimate it.

1.8.5 Estimating the G factor

Q. How should I estimate the G factor when fitting Fluorescence Anisotropy?

Our suggested approach is to:

1. Load a small molecule dye dataset (e.g. rhodamine – the key is that the rotational correlation time is small)

2. Load the IRF

3. In Decay, select the ‘G-factor’ mode

4. In the IRF menu, click ‘Estimate G factor’

5. Check that the dotted line in the decay window goes through the flat portion of the decay

1.8. Frequently asked questions 17
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CHAPTER 2

Common Abbreviations

FLIM Fluorescence Lifetime Imaging Microscopy
TCSPC Time Correlated Single Photon Counting
IRF Instrument Response Function
TVB Time Varying Background
FOV Field of View (synonymous to “image”)
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CHAPTER 3

Indices and tables

• genindex

• modindex

• search
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